
LESSON 6 Creating Charts PP-1

True/False Questions
Each of the following statements is either true or false. Select your choice 
by indicating T or F.

 1. PowerPoint offers only one slide layout choice for slides with charts.

 2. The sample worksheet in Microsoft Excel is always blank when you 
create a new chart.

 3. You cannot see the chart while you are working on the worksheet.

 4. You can change the colors of columns in a chart to whatever you find 
appealing.

 5. The units shown on the value axis are set by PowerPoint and cannot be 
changed.

 6. Every chart must include a legend.

 7. You must use a two-dimensional chart if you want to include a 
secondary axis.

 8. Double-clicking a pie slice or column enables you to change its size.

T    F 

T    F 

Concepts Review

Short Answer Questions
Write the correct answer in the space provided.

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

 1. How can you delete all of the sample data in the worksheet at one time?

 2. How do you change the grouping of the data series on a chart from 
columns to rows?

 3. While working on a chart, how do you display the worksheet if it is 
not visible?

 4. What type of number formatting do you apply to values to display 
dollar signs?

 5. What group found on the Chart Tools Format tab can you use to select 
different parts of a chart?

hin1926X_PPTL6_PP01-PP16.indd Page PP-1  10/4/08  10:03:09 PM user-s208hin1926X_PPTL6_PP01-PP16.indd Page PP-1  10/4/08  10:03:09 PM user-s208 /Users/user-s208/Desktop/TEMPWORK/September 08/18:09:08/MHBR065:204:Spilker/Users/user-s208/Desktop/TEMPWORK/September 08/18:09:08/MHBR065:204:Spilker



 

PP-2 UNIT 2 Presentation Illustration

 6. Which button can you click to change the color of a selected pie slice?

 7. How can you change the font size for chart labels without opening a 
dialog box or using the Ribbon?

 8. On a 2-D column chart, how can you change one of the data series to be 
displayed as an area chart?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. How do you decide if a chart is needed in your presentation? Do you 
think a presentation can have too many charts? Explain your answer.

 2. Imagine that you are trying to explain to someone how you spend your 
waking hours during a typical day. Can you think of a chart that would 
break down your activities into different categories and show how much 
time you spend on each during the day? Describe the chart’s appearance 
and the values that you would include.

Skills Review

Exercise 6-20
Insert a column chart.

 1. Open the file FinSum1.

 2. Create a chart by following these steps:

 a. Insert a new slide after slide 2 that uses the Title and Content layout.

 b. Key 2007 Quarterly Earnings for the title.

 c.  Click the Insert Chart icon  in the center of the content 
placeholder.

 d. Choose a 3-D Clustered Column chart and click OK.

 e.  In Microsoft Excel, click the upper-left box on the worksheet to select 
all the existing data and press .

 f. Key the data shown in Figure 6-21.
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LESSON 6 Creating Charts PP-3

 3.  Click in any cell of row 5 that was used in the sample worksheet. Right-
click and then choose Delete from the shortcut menu. Choose Entire 
Row; then click OK. This step removes the unused row and the empty 
space on the chart.

 4. Close Microsoft Excel.

 5.  Click the chart once in Normal view to select it; then use the chart’s 
corner sizing handles to reduce the chart’s height by approximately 
0.5 inches, and adjust the chart’s position for even spacing on the slide.

 6.  Edit the chart by following these steps:

 a.  Be sure the chart is selected; then from the Chart Tools Design tab, in 
the Data Group, click Edit Data .

 b.  Click cell E3 (Q4 for Los Angeles) to select it.

 c.  Key 1849 to replace the value “1539.” Press .

 d.  Still working on the Chart Tools Design tab, in the Data group, click 
the Select Data button . In the Select Data Source dialog box, click 
the red arrow at the end of the Chart Data Range box.

 e.  Click in Cell A1 and drag the pointer through E4 (the end of the data).

 f. Click the red arrow again, and click OK.

 g.  Still working on the Chart Tools Design tab, in the Data group, click 
the Switch Row/Column button .

 h.  Close Microsoft Excel.

 7.  Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [6-20your initials] as the footer.

 8.  Move to slide 1 and save the presentation as [6-20your initials] in your 
Lesson 6 folder.

 9.  View the presentation as a slide show; then preview and print it as 
handouts, three slides per page, grayscale, framed. Close the presentation.

Exercise 6-21
Edit and format an existing chart, change chart style, format the legend.

 1. Open the file Finance2.

 2. Edit the chart on slide 4 by following these steps:

 a. Click the chart to activate it.

 b.  From the Chart Tools Design tab, in the Data group, click the Edit 
Data button  to open Microsoft Excel.

Figure 6-21
Worksheet
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UNIT 2 Presentation IllustrationPP-4

 c.  On the worksheet, click cell B3 containing the value “�2%” and key 2 
to overwrite the negative value with a positive value. Press .

 d. Close Microsoft Excel.

 3. Change the style of the chart by following these steps:

 a.  From the Chart Tools Design tab, in the Chart Styles group, choose 
the More button .

 b. Choose Style 25.

 4. Change the font for the Horizontal (Category) Axis labels by following 
these steps:

 a. Click the category axis label “2007” to select the category axis.

 b.  Right-click on the axis and make the following changes from the 
floating font group: Choose the Tahoma font, a 20 point font size, 
and the Brown, Background 2 font color.

 5. Format the Vertical (Value) Axis by following these steps:

 a. Right-click a number on the value axis and choose Format Axis.

 b. For Major unit choose Fixed and key .05. Click Close.

 c.  Right-click on the axis and make the following changes from the 
floating font group: Choose the Tahoma font, a 20 point font size, 
and the Brown, Background 2 font color.

 6. Format the legend by following these steps:

 a.  Right-click the legend and choose Format Legend from the shortcut 
menu.

 b.  Under the Legend Position heading, choose Top Right and click Close.

 c.  Use the floating font group to change the legend font to Tahoma at a 
16 point font size.

 7. Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [6-21your initials] as the footer.

 8. Move to slide 1 and save the presentation as [6-21your initials] in your 
Lesson 6 folder.

 9. View the presentation as a slide show; then preview and print the 
presentation as handouts, four slides per page, grayscale, landscape, 
framed. Close the presentation.

Exercise 6-22
Add a chart, format chart axes, add a secondary axis, and combine chart 
types.

 1. Open the file Finance3.

 2. Add a slide after slide 3 with the Title and Content Layout.

 3. Key the title 2007 Special Events Revenue.

 4. Click the Insert Chart button  in the content placeholder. In the 
Column category, choose the Clustered Column chart. Delete the sample 
data and key the information in Figure 6-22. So that you can see all of 
the words entered into each cell of the worksheet in Microsoft Excel, 
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LESSON 6 Creating Charts PP-5

select the cells in the worksheet; then from the Home tab, in the Cells 
group, click Format and then choose AutoFit Column Width.

 5. Once the data is keyed, click on the row 4 heading and drag down to 
select both rows 4 and 5. Right-click and choose Delete.

 6.  In Microsoft PowerPoint, from the Chart Tools Design 
tab, in the Data group, click the Select Data button . 
In the Select Data Source dialog box, in the Chart data 
range box, change the D to an E and click OK.

 7.  From the Chart Tools Design tab, in the Data group, 
click the Switch Row/Column button .

 8.  Close Microsoft Excel.

 9. Add a secondary axis to the chart by following these steps:

 a.  Right-click one of the “Total Revenue” columns and choose Format 
Data series from the shortcut menu.

 b.  In the Plot Series On area, click Secondary axis. Click Close.

 10.  Change the chart type for the “Total Revenue” columns by following 
these steps:

 a.  Be sure the columns in this data series are still selected.

 b.  From the Chart Tools Design tab, in the Type group, click Change 
Chart Type button .

 c. In the Line category, choose the Line chart.

 d. Click OK.

 11. Change the formatting of the line for the data series by following these 
steps:

 a.  Select the line (being careful not to select the gridlines), then right-
click and choose Format Data Series from the shortcut menu.

 b.  Click Line Style at the left of the dialog box and change the Width to 
8 points.

 c.  Click Marker Options at the left of the dialog box and change the 
Marker Type to Built-In and the size to 15.

 d.  Click Marker Fill at the left of the dialog box and change to a Solid Fill, 
then make the color Tan, Text 2. Click Close.

 12. Format the secondary value axis by following these steps:

 a.  Right-click one of the numbers on the right side of the chart (on the 
Secondary Vertical (Value) Axis) and choose Format Axis.

 b.  Change the Major unit to Fixed and key 500.

 c.  Click Number at the left of the dialog box and choose Currency. For 
Decimal places key 0 and for Symbol choose $ English (United States). 
Click Close.

Figure 6-22
Worksheet

TIP

You started with a 2-D chart in this 
exercise since a 2-D chart is required to 

add a secondary axis.
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UNIT 2 Presentation IllustrationPP-6

 d.  Right-click the secondary axis again and use the floating font group 
to change the font to Arial.

 13.  Apply the following formatting to the Vertical (Value) Axis (on the left 
side of the chart) using the same process as for the secondary axis.

 a. Right-click the Vertical (Value) Axis and choose Format Axis.

 b.  Change the Maximum to Fixed and 250 and the Major unit to Fixed 
and 50.

 c.  Click Number at the left of the dialog box and choose Currency. For 
Decimal places key 0 and for Symbol choose $ English (United States). 
Click Close.

 d.  Right-click the vertical axis again and use the floating font group to 
change the font to Arial.

 14. Change the formatting of the Horizontal (Category) Axis. Right-click the 
category axis and change the font to Arial using the floating font group.

 15. Add chart titles and a legend by following these steps:

 a. Click to activate the chart.

 b.  From the Chart Tools Layout tab, in the Labels group, click the Axis 
Titles button .

 c.  Choose Primary Vertical Axis Title and Rotated Title.

 d.  Select the text that appears in the text box; delete it, and key Special 
Events (thousands).

 e.  Still working on the Chart Tools Layout tab, in the Labels group, 
click the Axis Titles button .

 f.  Choose Secondary Vertical Axis Title and Rotated Title.

 g.  Select the text that appears in the text box; delete it, and key Total 
Revenue (thousands).

 16. Right-click the legend and choose Format Legend from the shortcut 
menu and change the legend position to Top. Click Close.

 17. Reposition the chart, so it is centered horizontally on the slide, as 
shown in Figure 6-23.

Figure 6-23
Completed chart
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LESSON 6 Creating Charts PP-7

 18. Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [6-22your initials] as the footer.

 19. Move to slide 1 and save the presentation as [6-22your initials] in your 
Lesson 6 folder.

 20. View the presentation as a slide show; then preview and print the 
presentation as handouts, four slides per page, grayscale, landscape, 
framed. Close the presentation.

Exercise 6-23
Create and format a pie chart; add shapes, text boxes, and color.

 1. Open the file Apparel2.

 2.  Insert a new slide after slide 2 that uses the Title and 
Content layout. Key the title Apparel Mix— 2007.

 3.  Create a pie chart by following these steps:

    a.  Click the Insert Chart button  in the center of the 
content placeholder.

    b.  Click the Pie category and choose the Pie in 3-D 
chart type. Click OK.

    c.   On the worksheet, clear the sample information and 
key the information shown in Figure 6-24.

 4.   The sample data that you earlier 
deleted established a range of cells 
for the chart. However, not all of 
the current data is displayed in that 
range. Notice on the pie chart that no 
slice for Elbow Pads is included even 
though it is keyed on the worksheet.

 5.  From the Chart Tools Design tab, 
click Select Data. On the worksheet, 
notice that row 6 has not been 

  included in the selection. Highlight all the cells for the data you entered 
(A1 through B6) then click OK. Now all of the items have a slice.

 6. Close Microsoft Excel.

 7. Format a pie slice by following these steps:

 a.  Click the dark blue pie slice “T-shirts” once to select the entire pie.

 b.  Click the dark blue slice again to select the individual slice.

 c.  From the Chart Tools Format tab, in the Shape Styles group, click 
the Shape Fill button  and choose Light Blue from the Standard 
Colors category. This sets the color apart from the other blues.

 d.  Click these slices and change to the following standard colors: Bike 
Jerseys, light green; Visors, yellow; Knee Pads, red; and Elbow Pads, 
purple.

 8. Right-click the pie’s legend and choose Delete from the shortcut menu.

TIP

To use an em dash (the long straight line), 
key two hyphens with no space around 
them. Then space once after 2007 and 
the two hyphens will change to an em 

dash, a more contemporary punctuation 
mark. This adjustment is controlled with 

PowerPoint’s AutoCorrect feature.

Figure 6-24
Worksheet
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UNIT 2 Presentation IllustrationPP-8

 9. Add data labels by following these steps:

 a. Activate the chart.

 b.  From the Chart Tools Layout tab, in the Labels group, click the Data 
Labels button  and choose More Data Label Options.

 c.  In the Label Contains area, select the Category name and the 
Percentage check boxes and deselect the Value check box.

 d.  In the Label Position area, choose Best Fit.

 e. Click Close.

 10. Explode a pie slice by following these steps:

 a.  Select the red “Knee Pads” slice by clicking it twice.

 b.  Drag the slice slightly away from the center of the pie. The pie chart 
will become slightly smaller because of the additional space this 
requires. Therefore, increase the chart area slightly to compensate 
for this change.

 c.  Center the chart area horizontally on the slide.

 11. Insert a text box by following these steps:

 a.  From the Insert tab, in the Text group, click the Text Box button .

 b.  Click outside the chart area; draw the text box and key T-Shirts are 
still the best sellers.

 c.  Move the text box on top of the large light blue T-shirt pie slice. Change 
the text box font to 18-point Comic Sans MS, bold, Dark Blue, Accent 1. 
Resize the box so the text fits on two lines as shown in Figure 6-25.

Figure 6-25
Exploded slice and 

text box

 12. Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [6-23your initials] as the footer.

 13. Move to slide 1 and save the presentation as [6-23your initials] in your 
Lesson 6 folder.

 14. View the presentation as a slide show; then preview and print the 
presentation as handouts, four slides per page, grayscale, framed. Close 
the presentation.
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LESSON 6 Creating Charts PP-9

Exercise 6-24
Create a presentation containing a column chart and format the chart.

 1. Start a new presentation using the Median design theme and the Aspect 
theme color.

 2. Using the text in Figure 6-26, create a three-slide presentation; use the 
Title Slide layout for slide 1, and the Title and Content layout for slides 2 
and 3. The first line of each is the title for the slide.

Lesson Applications

Slide 1

Slide 2

Slide 3

Three Years of Phenomenal Sales 

Highlights

• New York revenue still increasing

• Miami and Los Angeles meeting goals

• Revenues reach 120% of budget

Sales by Region-2005 to 2007

Figure 6-26

 3. Right-align the title on slide 1.

 4. On slide 3, create a 3-D Clustered Column chart by using the data 
shown in Figure 6-27. Delete row 5.

Figure 6-27
Worksheet

 5. Close Microsoft Excel.

 6. Change the Vertical (Value) Axis options to have a Maximum of 12000 
and a Major unit of 3000. Change its Number formatting to $ English 
(U.S.) with no decimals.
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 7. Change to Chart Style 3.

 8. For the value and category axes and legend, change the font to 16 
points, not bold.

 9. Move the legend to the bottom. Resize, if necessary.

 10. Reposition the chart to keep spacing on both sides even. Resize if 
needed.

 11. Create a handout header and footer: Include the date and your name 
as the header, and the page number and text [6-24your initials] as the 
footer.

 12. Move to slide 1 and save the presentation as [6-24your initials] in your 
Lesson 6 folder.

 13. View the presentation as a slide show; then preview and print it 
as handouts, three slides per page, grayscale, framed. Close the 
presentation.

Exercise 6-25
Create and format a pie chart.

 1. Open the file Expense2.

 2. Insert a new slide after slide 1 that uses the Title and Content layout. Key 
the title Expense Breakdown.

 3. Create a 2-D pie chart on the new slide 2 by using the data from 
Figure 6-28.

Figure 6-28
Worksheet

 4. Add Percentage data labels only to the chart. Make them bold and 
change the font size to 32 points.

 5. Increase the legend font to 20 points, bold.
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 6. Change the chart title size to 28 points, bold and move it to the top left 
of the chart area.

 7. Change the chart to a Pie in 3-D.

 8. Explode the “Food” slice of the pie slightly.

 9. If any of the percentage labels move off the slices, then right-click, 
choose Format Data Label, and choose the Label Position Inside End or 
click and drag them onto the slices of the pie.

 10. Create a handout header and footer: Include the date and your name 
as the header, and the page number and text [6-25your initials] as the 
footer.

 11. Move to slide 1 and save the presentation as [6-25your initials] in your 
Lesson 6 folder.

 12. View the presentation as a slide show; then preview and print it as 
handouts, six slides per page, grayscale, scaled for paper, framed. Close 
the presentation.

Exercise 6-26
Insert a chart; change the chart to a combination chart; format the chart 
text, data series, and legend; add a secondary axis; and add a shape.

 1. Open the file Earnings2 and apply the Oriel design theme using the 
Concourse theme color.

 2. Resize and reposition the title on slide 1 so that it is right above the 
subtitle.

 3. Insert a new slide between slides 2 and 3 that uses the Title and Content 
layout. Key the title Gross Income.

 4. Create a clustered column chart on the new slide by using the data in 
Figure 6-29.

Figure 6-29

LESSON 6 Creating Charts PP-11
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 5. Select all of the rows and columns in the worksheet so that all data is 
included in the chart.

 6. Switch Row/Column.

 7. Close Microsoft Excel.

 8. Be sure you are using a 2-D column chart.

 9. Plot the “Year Total” data series on a secondary axis. Change the chart 
type for the series to Line Chart. Format the line in a matching color and 
change the width to 10.

 10. Change the font for the Vertical (Value) Axis, Horizontal (Category) 
Axis, the Secondary Vertical (Value) Axis, and Legend to 16-point Arial 
(not bold).

 11. For the Vertical (Value) Axis (on the left), change the units to minimum 
0 and maximum to 8,000 displayed Fixed at major units of 2,000 and 
change the Number formatting to Currency with no decimal places.

 12. Format the Secondary Vertical (Value) Axis (on the right) with the 
units to minimum 0 and maximum to 30,000 displayed Fixed at major 
units of 5,000 and change the Number formatting to Currency with no 
decimal places.

 13. Move the legend to the bottom of the chart.

 14. Expand the width and height of the chart area.

 15. Expand the width of the legend so all parts of the legend fit on one line. 
Apply a light blue fill to the legend area to distinguish it from the slide 
background.

 16. Apply a gradient fill to the columns in each data series. After the first 
data series has been changed, you will need to reset the fill color for 
each series selected and then apply the gradient coloring. Choose Linear 
Up in the Dark Variations category so the lightest color is on top.

 17. Click outside the chart area to deselect the chart.

 18. Now work in the area at the top of the chart to create these graphic 
elements and then move them into position when complete. You might 
want to use Zoom to increase the size of the slide so you can work 
better in detail.

 a.  Create a text box centered above the chart. Key Impressive!  in the 
text box. Change the font to 24-point Arial.

 b. Draw a small, 5-Point Star with a yellow fill and red outline.

 c. Place the star on the top of the New York column for the year 2007.

 d. Place the text box above the columns near the star, as shown in 
Figure 6-30.
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 19. Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [6-26your initials] as the footer.

 20. Move to slide 1 and save the presentation as [6-26your initials].

 21. View the presentation as a slide show; then preview and print slide 3 in 
grayscale.

 22. Close the presentation.

Exercise 6-27  Challenge Yourself
Insert a chart; change the chart style; apply gridlines; format the chart 
text, data series, and legend; add a picture fill to a chart; and add a shape.

 1. Open the file Suppliers.

 2. On slide 1, key Your Name as the subtitle.

 3. Insert a new slide after slide 2 that uses the Title and Content layout. For 
the slide title, key Produce Cost Comparison.

 4. Create a 3-D Clustered Column chart on the new slide by using the data in 
Figure 6-31. On your worksheet in Microsoft Excel, select all of the cells 
for the chart, then from the Home tab, in the Cells group, click Format 
and choose AutoFit Column Width so all text is visible in the cells.

Figure 6-30
Completed chart

Figure 6-31
Worksheet
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 5. Change the chart style to Style 7.

 6. Change the Floor color to the orange that matches the slide design.

 7. Select the legend and change to a Top position.

 8. Deselect the chart. Draw a rectangle shape over “Patty’s Produce” in the 
legend area then change the Fill color to None and the outline to Orange.

 9. Add a text box on the right and key Lowest Costs. Change the Fill color 
to Orange and the text color to Dark red and font size to 18 points.

 10. Add an arrow from the text box pointing to “Patty’s Produce.” Change 
the Fill color and the Outline color to Orange, as shown in Figure 6-32.

Figure 6-32
Completed chart

 11. Insert a new slide after slide 3 using the Title and Content layout. For the 
slide title, key Lead Time Comparison.

 12. Insert a Line with Markers chart and enter the data below in Figure 6-33 
into the chart. Delete columns C and D and row 5.

 13. Select the data from A1 through B4 so that the chart appears correctly.

Figure 6-33
Worksheet
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LESSON 6 Creating Charts PP-15

 14. Remove the legend. If the chart title did not automatically appear, title 
the chart Days from Order to Delivery.

 15. Increase the width of the line to 8 points and make it Dark red, Accent 2. 
Change the Marker Options to Built-in and increase the marker size to 
28 points and make it Orange.

 16. Reposition the chart to fit evenly on the dark area of the slide.

 17. Draw a green, 5-pointed star and place it in front of the supplier’s name 
with the lowest lead time.

 18. Change the font color of the Value and Category Axes and the chart title 
to Dark red, Accent 2.

 19. Insert the picture Apple from your data files into the background of the 
chart.

 20. Change the gridline color to orange, as shown in Figure 6-34.

Figure 6-34
Completed chart

 21. Create a handout header and footer: Include the date and your name as 
the header, and the page number and the text [6-27your initials] as the 
footer.

 22. Move to slide 1 and save the presentation as [6-27your initials].

 23. View the presentation as a slide show; then preview and print it as 
handouts, four slides per page, grayscale, landscape, framed. Close the 
presentation.
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In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 6-28
Obtain a list of stock quotes either online or from the Wall Street Journal. 
Create a chart listing at least five of your stock picks. Compare the prices 
of each stock visually through a chart. Create another chart showing the 
percentage change in stock value since closing the day before compared 
with the other stocks you have chosen. In addition, create a separate slide 
for each stock, giving details about the company. Format the presentation 
in a way that will hold a viewer’s attention. Save your presentation as 
[6-28your initials]. Preview, and then print the presentation as handouts.

Exercise 6-29
Make a list of your activities during a typical weekday, including the actual 
time you spend on each activity. Group your activities into no more than 
eight categories. Make sure the times add up to 24 hours. Add a second set 
of times listing the amount of time you should be spending on each activity, 
and a third set of times listing the amount of time you would prefer to spend. 
(Don’t be too serious about the times—make it fun.) Create a column or bar 
chart to represent these times, and then add three pie chart slides, one for 
each set of times (actual, should, prefer). Add a title slide and a conclusion 
slide. Use your creativity to make the charts interesting and fun to view 
including colors, pictures, shapes, and 3-D rotation. Save the presentation as 
[6-29your initials]. Preview, and then print the presentation as handouts.

Exercise 6-30
Research the information about your state of residence from the current 
census and other online resources. Prepare slides to explain the facts that you 
find using bulleted lists and charts. Find some statistics about diversity within 
your state, home ownership in your state compared to the national average, 
types of businesses, etc., and create at least two charts to display the statistics. 
Add a title slide and a conclusion slide. Format your presentation attractively, 
save it as [6-30your initials], and then print handouts.

On Your Own

UNIT 2 Presentation IllustrationPP-16
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